
|

 
 
 
 
 
 

HCL Notes/Domino Version 11.0 Beta 1 
 

HCL Notes/Domino 11 の新機能 
Doc Version: 2019/09/03 

 

 
 
 
 
Send comments in English to: 
kendra.bowker@pnp-hcl.com 
natalie.mezzina@pnp-hcl.com 
 
 
 
  



|
 

 

 

 

 

もくじ 
Notes/Domino 11 の新機能 .................................................................................................................... 4 
Notes 11 の新機能 ............................................................................................................................... 4 

新しいモダンな外観............................................................................................................................. 4 
すっきりした、モダナイズされた UI .............................................................................................................. 4 
最小限のメニュー構成 ......................................................................................................................... 4 
簡略化されたフォーム .......................................................................................................................... 4 

受信ボックスのアクション・バー ..................................................................................................................... 5 
サイド・ナビゲーター・メニュー ...................................................................................................................... 5 
クライアントステータス通知 ........................................................................................................................ 5 
見逃されたアラーム ................................................................................................................................ 5 

メール・エディター・ツールバー ................................................................................................................... 6 
新しいカレンダー フォーム ....................................................................................................................... 6 
新しい連絡先フォーム .......................................................................................................................... 6 

Notes 11 の新しいテーマ ........................................................................................................................ 7 
新しくなった Teamroom テンプレート ........................................................................................................ 7 

機能拡張・改善 ................................................................................................................................... 8 
言語のスペル チェック ........................................................................................................................... 8 
PDF へのエクスポート .......................................................................................................................... 8 
24 時間を超える会議招集のサポート ........................................................................................................ 8 
3 クリックのサポート ............................................................................................................................. 8 

HCL ノートのその他の機能強化 ................................................................................................................. 9 
同期リリース・スケジュール ...................................................................................................................... 9 
SAML 用に TLS 1.2 をサポート ............................................................................................................. 9 
Mac 64 ビット用アンインストーラー ........................................................................................................... 9 
フォルダーの移動プロンプト ..................................................................................................................... 9 

Domino 11 の新機能 ........................................................................................................................... 10 
InstallAnywhere インストール・プラットフォーム ............................................................................................. 10 

Silent install mode on Windows..................................................................................................... 10 
Linux でのサイレント・インストール・モード .................................................................................................. 10 

新しい Java ランタイム環境 .................................................................................................................... 10 
IBM GSKit 暗号ライブラリーを OpenSSL に置き換える ................................................................................... 11 
SAML 統合ログイン時、ID Vault からの ID ファイルのダウンロード制限は無効に ......................................................... 11 
ID Vault 内の ID パスワードに対する Web ユーザーの認証 ............................................................................... 11 
ディレクトリー同期 (Directory Sync) ....................................................................................................... 13 

ディレクトリー同期の構成 .................................................................................................................... 13 
1. ディレクトリー同期用のディレクトリー・アシスタンス文書の作成 ...................................................................... 13 
例: Base DN for search ................................................................................................................ 17 
2. ディレクトリー同期の構成文書の作成 ................................................................................................ 18 
ディレクトリー同期の状況監視 ............................................................................................................... 20 
Active Directory 上でユーザー名が変更されたときに Domino ユーザー名を変更する ............................................. 20 



|
 

 

 

 

 
Domino 上での Active Directory ユーザーの登録 .................................................................................... 21 
ユーザーとグループの削除 .................................................................................................................... 21 
ディレクトリー同期の構成の変更 ............................................................................................................ 21 
すべてのデータの再同期 ..................................................................................................................... 22 

開発者向けの新機能 ............................................................................................................................. 23 
Domino Query Language の拡張機能 .................................................................................................. 23 
Domino Query Language の文書 ....................................................................................................... 23 

Domino Query Language の概要 .................................................................................................... 23 
はじめに(Getting started) ................................................................................................................ 23 

DQL syntax ................................................................................................................................... 24 
単純なクエリーの例 .............................................................................................................................. 25 
値のデータ形式 .................................................................................................................................. 25 
Booleans ....................................................................................................................................... 25 

Precedence ................................................................................................................................ 26 
contains ........................................................................................................................................ 26 

テキスト文字列値 ............................................................................................................................ 27 
日付と時刻の値 .............................................................................................................................. 27 

置換変数 ........................................................................................................................................ 28 
列の要件の表示 ............................................................................................................................. 28 
スキャン制限 .................................................................................................................................. 29 
パフォーマンスとリソース消費 ................................................................................................................. 29 
設計カタログ (Design catalog) .......................................................................................................... 30 
DomQuery ユーティリティー ................................................................................................................ 30 
explain....................................................................................................................................... 31 

Traveler の新機能 ............................................................................................................................... 32 
カレンダー・イベントでの添付ファイルの閲覧 ................................................................................................. 32 
ActiveSync 16.x のサポート .............................................................................................................. 32 
APNS HTTP/2 のサポート ................................................................................................................. 32 

 



 

Notes/Domino 11 の新機能 
 
この文書では、HCL Notes/Domino および HCL Traveler の新機能と機能強化について説明しています。 
 

Notes 11 の新機能 
新しいモダンな外観 
HCL Notes 11 の外観は、シンプルさとユーザー指向を考慮して設計されました。 

すっきりした、モダナイズされた UI 
このリリースでは、Notes のカラー・スキームなど全体的な外観が変更されました。 

 

最小限のメニュー構成 
使用されるアクションとオプションは、必要になるまで非表示になります。ドロップダウン・メニューと展開メニューを使用すると、ワ
ークスペースを煩雑な状態にすることなく、以前のすべての機能を利用できます。 

簡略化されたフォーム 
Notes カレンダーと連絡先のフォームは基本重視の構成、およびユーザー・フレンドリーなレイアウトになっています。 
 
注意: これらの機能強化部分を表示するには、メール・テンプレートをアップグレードし、テンプレートを最新バージョンに変更し
てください。 

  



 

受信ボックスのアクション・バー 
受信トレイの上にあるアクション・バーのアイコンが少なくなりました。電子メールを選択してカーソルを合わせると、さらにオプショ
ンを表示されます。 

 
各アイコンには、既定のアクションとドロップダウン メニューがあります。 

サイド・ナビゲーター・メニュー 
 デフォルトでは、[迷惑メール] や [ゴミ箱] などの使用が少ないアイテムは折りたたまれます。Show More をクリックしてこ
れらのオプションを表示し、Show Less をクリックして非表示にします。 
 
ミニ・ビューもデフォルトで折りたたまれます。Show と Hide オプションを使用して、ミニ・ビューコンテンツを表示および非表示
にできます。 

クライアントステータス通知 

下部アクション・バーのベルアイコンをクリックすると、クライアントのステータスメッセージが表示されます。  

見逃されたアラーム 
一番下のアクション・バーのベルアイコンをクリックすると、Notes クライアントが起動していない間に見逃されたカレンダー・イベン

トが Missed Alarm として表示されます。  
 
任意のタイミングでアラームを表示し閉じることができます。以前はログインするとすぐに表示されていました。 
 
注意: 見逃されたアラーム通知を有効にするには、[カレンダーのエントリ] ページで [カテゴリーの下に通知] を選択します。 
 
 



 

メール・エディター・ツールバー 
入力する場所に近い位置のツールバーにテキスト編集オプションが表示されるようになりました。 
注意: この機能はデフォルトではオンになっていません。ベータ 1 のリリースノートを参照してください。 

新しいカレンダー フォーム 
簡略化された形式でカレンダー・イベントを作成します。左側に件名などの欄、右側に参加者欄に分離し、画面の有効利用
と視認性の向上を図りました。 

 
 

新しい連絡先フォーム 
簡略化されたフォームで新しい連絡先を追加できるようになりました。 

 
 

  



 

Notes 11の新しいテーマ 
HCL Notes には、メール、カレンダー、連絡先、ノートブックの新しいテーマがあります。 

 
 
Notes 11 のテーマはデフォルトでオンになっていますが、インターフェイスを以前のテーマに切り替えることもできます。
File > Preferences, Fonts, Colors, and Themes を選択して、ディスプレイの色やバージョンを変更できます。 
 
Notes.ini 設定 
Notes 11 では Notes 11 クライアントにカスタムカラーテーマを適用するための notes.ini の設定、
CUSTUM_THEME_COLOR がサポートされました。 
 
notes.ini 設定手順 
デスクトップ設定ポリシーのカスタム設定タブに次の設定を追加します。 

CUSTOM_THEME_COLOR=<R>,<G>,<B> 

where <R>,<G>,<B> represent the red, green, and glue values to use as the basis for the theme 
color. For example: 
<R>、<G>、<B>は、カラーの基礎として使用する赤、緑、青の値を表します。例を示します。 

CUSTOM_THEME_COLOR=128,0,128 

テーマのさまざまな色を評価し、その色 RGB 値を表示するには、File > Preferences > Fonts, Colors, and 
Themes をクリックします。HCL テーマを選択した場合は、Customize Theme をクリックします。Choose your 
theme の横にあるカラー・ボックスをクリックします。 

新しくなった Teamroom テンプレート 
このベータ版では、更新された Teamroom テンプレートをサポートしていますが、デフォルトではオンになっていません。新しい
ものを使うには teamroom11.ntf テンプレートを適用します。 



 

機能拡張・改善 
HCL Notes 11 の新機能の詳細について解説します。 

言語のスペル チェック 
HCL Notes クライアントがサポートするすべての言語について、メールや文書内でスペル・チェックを行えるようになりました。利
用可能な辞書を使用してテキストをチェックする手順は以下の通りです。 

1.  スペル・チェックしたいテキストをハイライトします。 
2.  Tools > Language を選択し適切な言語を選択します。 

PDF へのエクスポート 
HCL Notes クライアントから、メールや文書を PDF でエクスポートできるようになりました。 

注意: Windows マシンで PDF エクスポートをサポートするためには PDF プリンターが必要です。PDF にエクスポートする方
法は以下の通りです。 

1. エクスポートする電子メールまたは文書に移動します。 
2. File > Export > Save as Type > PDF を選択します。 

注意: メール・スレッドは、PDF でエクスポートすると自動的に展開されます。 
注意: 添付ファイルを PDF としてエクスポートする機能は、このベータ版では使用できません。 

24時間を超える会議招集のサポート 
HCL Notes カレンダーで 24 時間を超える会議がサポートされるようになりました。 

注意: この機能を使うには Notes 11 のテンプレートが必要です。 
 
24 時間以上の会議の期間がカレンダーに正確に表示されます。会議は開催される各予定表の最上部に表示されますが、
1 日全体をブロックしません。 

注意: このベータ版では、受信のみに限り 24 時間以上の会議がサポートされています。Notes で 24 時間以上の会議を
作成することはまだできません。複数日にわたる会議招集について新しい会議時間を提案する場合は、ドラッグ&ドロップを使
います。 

3 クリックのサポート 
このベータ版では、3 クリック・サポートがサポートされています。3 クリック サポートにより、ユーザーが電子メール内で添付ファイ
ルを開く際のセキュリティーが向上します。ユーザーが添付ファイルをダブルクリックすると、Open/Save/View ダイアログ ボッ
クスが表示されます。3 クリック・サポートが有効の場合、選択したアクションを確認するメッセージが 2 番目のメッセージ・ボック
スで表示されます。この設定を有効にするには、Notes.ini 設定に EnableThreeClicks=1 を追加します。 

 
  



 

HCL ノートのその他の機能強化 

同期リリース・スケジュール 
このリリース以降、Sametime と Notes は同じリリース・スケジュールとなります。 

SAML用に TLS 1.2 をサポート 
Notes クライアントと内蔵 Sametime クライアントは TLS 1.2 をサポートし、Notes のフェデレーション・ログイン(SAML)を
利用できるようになりました。この機能強化は、Notes 内の XULRunner (ズールランナー) ブラウザを最新バージョン(TLS 
1.2 をサポート)にアップグレードした結果です。 

Mac 64 ビット用アンインストーラー 
Mac の Notes 11 で提供されるアンインストーラーは 64 ビット対応になりました。この変更は、Apple が 9 月に予定してい
る Mac OS 10.15 (Catalina) リリースの時点で 32 ビット・アンインストーラーをサポートしなくなるためです。64 ビット・アン
インストーラーを使用して、Mac OS 10.15、10.14、10.13 で実行されている Notes 11 をアンインストールできます。ベ
ータ版の参加者は、Notes 11 をインストールし、アンインストールすることで、この機能のテストが行えます。 
 
注意: オプション: Notes 11 をインストールしてアンインストールする前に、Mac OS 10.15 にアップグレードできます。 

フォルダーの移動プロンプト 
フォルダーの移動を確認するメッセージが表示されます。このベータ版以前では確認プロンプトがなく、誤ってフォルダーを移動し
たり失う可能性がありました。 

 
 
 
 
 

  



 

Domino 11 の新機能 

InstallAnywhere インストール・プラットフォーム 
HCL Domino 11 のインストールでは Flexera InstallAnywhere 2018 がプラットフォームとして使用され、以下のインス
トール・モードが提供されています。 

• グラフィカル・ユーザー・インターフェイス (GUI) モード。インストール GUI は直感的で、以前の Domino リリースと同じ
オプションを提供しますが、外観は若干異なります。 

• コンソール・モード。Linux では、コンソール・モードは以前のリリースと似ていて、わずかな違いしかありません。Windows
ではこのモードはサポートされません。 

• サイレント・インストール・モード。詳細は次の手順を参照してください。 

注意: このベータ版では Domino の新規(クリーン)インストールが必要です。アップグレードはまだサポートされていません。 

Silent install mode on Windows 

Windows でのサイレント インストール モード 
1. 次のコマンドを実行して、応答ファイルを生成します。応答ファイルは UTF-8 形式である必要があります。 

install.exe -r C:\temp\myresponse.properties 

2.  次のコマンドを実行して、応答ファイルを使用して、サイレント モードで Domino をインストールします。 

install.exe -f C:\temp\myresponse.properties -i silent 

Linuxでのサイレント・インストール・モード 

1. 次のコマンドを実行して、応答ファイルを生成します。作成されたファイルは /tools に作成されます。応答ファイルは 
UTF-8 形式である必要があります。 

sudo ./install -r myresponse.properties 

2. 次のコマンドを実行して、応答ファイルを使用して、サイレント モードで Domino をインストールします。 

sudo ./install -f /home/tools/myresponse.properties -i silent 

新しい Java ランタイム環境 
HCL Domino 11、HCL Domino Designer 11 に付属する Java ランタイム環境(JRE)は、AdoptOpenJDK を通じ
て提供される Eclipse OpenJ9 になりました。JRE コンポーネントのバージョンは次のとおりです。 
• Openjdk: version 1.8.0_202 
• OpenJDK Runtime Environment: build 1.8.0_202-b08 
• Eclipse OpenJ9 VM: build openj9-0.12.1, JRE 1.8.0 Windows 10 amd64-64-Bit Compressed 

References 20190205_265. JIT enabled, AOT enabled 
• OpenJ9: 90dd8cb40 
• OMR: d2f4534b 
• JCL: d002501a90 based on jdk8u202-b08 

以前のリリースと同様に、notes.ini 設定 JavaEnableJIT=0 を使用して、ジャスト イン タイム (JIT) コンパイラをオフに
することができます。以前のリリースと同様に、JIT はデフォルトでオンになっています。 



 

IBM GSKit 暗号ライブラリーの OpenSSL への置換 
このベータ版では、IBM GSKit を置き換えるために、以下の OpenSSL 暗号化ライブラリーが提供されています。 
 
表 1: 暗号ライブラリーの変更 

プラットフォーム 
デフォルト 

暗号プロバイダー 
FIPS認証モードの 
デフォルト設定 

サポートされている notes.ini設定 

Domino W64 
Linux 64 

OpenSSL 1.1.1a No 
FIPS 認証を受けた OpenSSL 2.0 モジュールを使用
する場合は、次の設定を使用します。 
HCC_FIPS_NON_CERTIFIED=0 

Notes W32 IBM GSKit Yes 

FIPS 非対応の OpenSSL 1.1.1a ライブラリーに切り
替えるには次の両方を設定します。 
NOICC=1 
HCC_FIPS_NON_CERTIFIED=1 

Notes Mac OpenSSL 1.1.1a Yes なし 
 

SAML統合ログイン時、ID Vaultからの ID ファイルのダウンロード制限は無効に 
SAML Notes フェデレーション・ログイン、または SAML Web フェデレーション・ログインで、ID Vault から Notes ID ファイ
ルを抽出して認証する方法である場合、ID Vault ポリシー設定の Allow automatic ID downloads は無視されま
す(この設定は、セキュリティー設定ポリシー文書の ID Vault タブにあります)。 
 
SAML 認証では、ID Vault から ID ファイルの無制限のダウンロード・アクセスが必要なため、この設定は無視されます。 
 
注意: Allow password authentication with the ID vault がフェデレーション・ログインのために有効になってい
る場合でも、パスワード認証では Allow automatic ID downloads 設定は継続して使用されます。Allow 
password authentication with the ID vault 設定は Federated Login > Additional settings for 
Federated Login (Notes or Web)のセキュリティー・ポリシー設定文書のセクションにあります。 

ID Vault内の IDパスワードに対するWeb ユーザーの認証 
サーバーにアクセスする Web ユーザーを認証する際、ID Vault 内のパスワードを使用できるようになりました。 
  
この機能を有効にすると、HCL Verse、HCL iNotes、そして Notes ID を持つ他の Web ユーザーからの認証要求にたい
して、Domino サーバーは、ID Vault から Web 名と Notes ID パスワードを取り出し認証します。ユーザーは 1 つのパス
ワード(Notes ID パスワード)を覚えておく必要があります。この機能を使用しない場合、Web ユーザーはサーバーに対して
認証を受けるための HTTP パスワードを入力し、Notes ID パスワードが HTTP パスワードと異なる場合は、安全なメール
操作を実行する際に Notes ID のパスワードを入力するよう求められます。 
 
注意: この機能は、次のユーザーの認証では無視されます 
• Notes クライアント・ユーザー 
• Notes ID を持たない(ID が作成されていない)Web のみのユーザー 
• SAML フェデレーション ID 認証を使用して認証するユーザー 



 

この機能を有効にする手順は以下の通りです。 

1. Domino ディレクトリーで、サーバー構成文書を新規作成あるいは編集します(Configuration > Servers 
>Configurations)。 

2. Security タブをクリックします。 

3. Internet Password Verification セクションで以下のオプションからひとつを選択します。 

 
表 2: インターネット・パスワードの確認オプション 

オプション 説明 
Check internet password in 
directory 

常に Domino ディレクトリーのユーザー文書のインターネット・パスワードを使用
して、Web ユーザーを認証します。このオプションは 11 より前の動作であり、デ
フォルト設定です。 

Check internet password in 
vault 

Vault 内の Notes ID ファイルのパスワードを常に使用して、Notes ID を登
録した Web ユーザーを認証します。これらの Web ユーザーは、認証のために 
Vault 内に ID を持っている必要があります。 

Check vault first, then 
directory. 

Vault 内の Notes ID のパスワードを使用して、Notes ID が登録された
Web ユーザーの認証を試みます。Vault に Notes ID が見つからなかった場
合には、Domino ディレクトリーのユーザー文書のインターネット・パスワードを使
用してユーザーを認証します。 

Notes ID を登録済みの一部の Web ユーザーについて、ID を ID Vault 保
存されていない場合や、はっきりしない場合にはこのオプションを使用します。 

 

  



 

ディレクトリー同期 (Directory Sync) 
ディレクトリー同期を使用すると、外部 LDAP ディレクトリーから Domino ディレクトリーにユーザーとグループのデータを同期
できます。現在のところ、Active Directory のデータと同期できます。 
 
ディレクトリー同期を使用すると、HCL Domino ユーザーは Active Directory に登録されている Microsoft Outlook 
ユーザーなど Notes を使用しない組織内のユーザーのメール・アドレスをメール作成時に簡単に指定できたり、ユーザーの詳
細を閲覧できるようになります。この機能を使用すると、Active Directory のみのユーザーについて、自動的に Domino
ディレクトリーにユーザー文書が作成され、Notes ユーザーはそのユーザーのアドレスやその他の情報を見つけることができます。
DirSync を使用しない場合、Notes ユーザーは、ユーザー文書を手動で追加しておかない限り、メールを送信する前に 
Active Directory ユーザーのアドレスを知っている必要があります。 
 
DirSync と呼ばれるタスクは、Active Directory から Domino ディレクトリーに指定したフィールドを同期します。フィールド
の内容は、常に Active Directory 側で制御されます。 
 
Domino ディレクトリーのユーザー文書内の GUID フィールド(非表示)は、Active Directory の一意のレコードに紐付けさ
れます。ディレクトリー同期には、次のコンポーネントが含まれています。  
 
• ディレクトリー同期が有効になっているディレクトリー・アシスタンス・データベース内に作成された LDAP ディレクトリー・アシ

スタンス文書。Domino サーバーは、この文書を使用して、同期のために Active Directory サーバーに接続します。 

• Domino ディレクトリーのディレクトリー同期ビューで作成されたディレクトリー同期構成文書。この文書では、Active 
Directory のどのフィールドを Domino と同期させるのか、他のオプションも使いながら制御します。 

• DirSync は Domino 管理サーバー上でのみ実行されるサーバー・タスクで、Active Directory サーバーに定期的に
接続して、ユーザーやグループの変更をプルして Domino ディレクトリーに反映させます。 

• 管理者は、Active Directory でユーザーの名前が変更されたときに、登録済みの Domino ユーザーの名前が変更さ
れるように設定できます。Active Directory のユーザーの共通名が変更されると、管理プロセス要求、Rename 
Common Name が作成されます。管理者は、標準の管理プロセスの名前変更要求を開始する要求を承認します。 

• ディレクトリー同期機能は、Domino 側で Active Directory ユーザーを登録する機能を提供します。 

ディレクトリー同期の構成 
ディレクトリー同期を構成するには、次の手順を実行します。 
1. ディレクトリー同期用のディレクトリー・アシスタンス文書を作成します。 

2. ディレクトリー同期構成文書の作成 

1. ディレクトリー同期用のディレクトリー・アシスタンス文書の作成 
ディレクトリー同期を構成する最初の手順は、ディレクトリー同期が有効になっているディレクトリー・アシスタンス・データベース
にディレクトリー・アシスタンス文書を作成することです。この手順では、次の手順を完了したことを前提としています。 
 
• ディレクトリー・アシスタンス・データベースの作成とレプリケート 

• ディレクトリー・アシスタンス・データベースを使用するサーバーの設定 

 

https://www.ibm.com/support/knowledgecenter/ja/SSKTMJ_9.0.1/admin/conf_creatingandreplicatingadirectoryassistancedatabase_t.html
https://www.ibm.com/support/knowledgecenter/ja/SSKTMJ_9.0.1/admin/conf_settingupserverstouseadirectoryassistancedatabase_t.html


 

注意: 既存のディレクトリー・アシスタンス・データベースを使用している場合は、その設計を Domino 11 で提供される 
da.ntf テンプレートで置き換えます。Notes からデータベースを開き File > Application > Replace Design を選
択します。 
 
この手順では、ディレクトリー同期に適用されるディレクトリー・アシスタンス文書のフィールドについてのみを説明します。 
 
1. TCP/IP ping ユーティリティーを使用して、HCL Domino サーバーが Active Directory サーバーに接続できること

をテストします。 

2. Domino 管理者から File > Open Server を選択して、ドメインの Domino 管理サーバーを開きます。OK をクリ
ックします。 

3. Configuration タブをクリックします。 

4. ナビゲーション領域で、Directory > Directory Assistance を展開します。Server Error: File does not 
exist が表示された場合には、管理サーバーはディレクトリー・アシスタンス・データベースを使用するように設定されていな
いことを示しています。 

5. Add Directory Assistance をクリックします。 

6. Basics タブで以下のフィールドを設定します。 

表 3: Basics タブ 
フィールド 入力内容 

Domain type LDAP を選択 
Domain name ディレクトリー・アシスタンス・データベース内の他のディレクトリー・アシスタンス文書

(HCL Notes または LDAP) に指定されたドメイン名とは異なる、任意のドメイ
ン名。たとえば、Renovations AD などです。 

Make this domain available 
to 

Directory Sync を選択 
注: 必要性がある場合を除き、Notes clients and Internet 
Authentication/Authorization や LDAP Clients を選択しないこと。 

Group authorization No を選択 
Enabled Yes を選択 

注意: ディレクトリー・アシスタンス・データベースのメイン・ビューから、このディレクト
リーのディレクトリー・アシスタンスを有効または無効にすることもできます。ディレクト
リーのディレクトリー・アシスタンス文書を選択し、ツールバーで Enable/Disable
をクリックします。 

7. (オプション) Naming Contexts (Rules)タブで、ディレクトリーに対して定義したいルールごとに、以下のフィールドを
設定します。名前付けルールの詳細については、「ディレクトリーアシスタントと命名規則」を参照してください。 

  

https://www.ibm.com/support/knowledgecenter/ja/SSKTMJ_9.0.1/admin/conf_directoryassistanceandnamingrules_c.html


 

表 4: Naming Contexts (Rules) タブ 

フィールド 入力内容 
N.C. # LDAP ディレクトリー内のユーザー名を記述する名前付きコンテキスト (ルール) を

入力します。 
Enabled 次のいずれかを選択します。 

• Yes: ルールを有効にする場合 
• No: ルールを無効にする場合(デフォルト) 

Trusted for Credentials 次のいずれかを選択します。 
• Yes: サーバーが LDAP ディレクトリー内の資格情報を使用して、ディレクト
リー内の識別名(DN)がルールに対応するインターネット・クライアントを認証できる
ようにする。 
• No: (デフォルト) ディレクトリー内の識別名がルールに対応するインターネット 
クライアントをサーバーがこのディレクトリーを使用して認証できないようにする。 

8. LDAP タブで、以下のフィールドを設定します。 

表 5: LDAP タブ 

フィールド 入力内容 
LDAP Configuration セクション  
Hostname Active Directory のホスト名 (例: ad.renovations.com) 

Domino サーバーは、このホスト名を使用してディレクトリー・サーバーに接続し
ます。 

Suggest をクリックして、DNS にリストされている LDAP サーバーのホスト名を
調べることができます。 
Verify をクリックして、ホスト名がアクティブな LDAP サーバーであることを確認
します。 

または、 

指定された最初のホスト名で表されるディレクトリー・サーバーが使用できない場
合に、Domino サーバーが代替の LDAP ディレクトリー・サーバーを使用できる
ように、追加のホスト名を入力します。コンマ、セミコロン、または新しい行に各ホ
スト名を入力して、ホスト名を分離します。 

複数のディレクトリー・サーバーを指定し、それぞれが異なるポートでリッスンする
場合は、ホスト名の後にポートを指定します。例： 
ad1.renovations.com:390, 
ad2.renovations.com:391 
このフィールドに入力されたポート値は、Port フィールドで指定された値をオー
バーライドします。このフィールドにポートが指定されていない場合は、Port フィー
ルドで指定された値が使用されます。 

LDAP Vendor Active Directory を選択 
  



 

Optional authentication 
credential for search 

Optional Authentication Credential には、Active Directory サー
バーに接続するときに表示する Domino サーバーのユーザー名とパスワードを入
力します。Active Directory サーバーは、名前とパスワードを使用して 
Domino サーバーを認証します。名前とパスワードを指定しない場合、Domino 
サーバーは匿名で接続しようとします。 
Verify をクリックして、入力したユーザー名とパスワードが各ホスト名で有効であ
ることを確認します。 
この設定は、LDAP サーバーの変更検出に影響を与える可能性があります。 

Base DN for search 検索ベース。LDAP ディレクトリー・サーバーが必要とする場合に使用。 
o=Renovations 
o=Renovations,c=US 
Suggest をクリックして、各ホスト名を検索して、検索ベースの可能性が高
い場合を検索します。 
Verify をクリックして、構成した資格情報を使用して、各ホスト名で検索
ベースにアクセス可能であることを確認します。  
この設定は、LDAP サーバーの変更検出に影響を与える可能性があります。 

Connection Configuration 
セクション 

 

Channel encryption 次のいずれかを選択します。 
• SSL: Domino サーバーが Active Directory サーバーに接続するときに 
SSL を使用する (デフォルト) 
• None: SSL を使用しない。 

SSL を選択した場合は、次の関連フィールドで選択を行います。 
• 期限切れの SSL 証明書を受け入れる 
• SSL プロトコル・バージョン 
• リモート・サーバーの証明書を使用してサーバー名を確認する  

Port Domino サーバーが Active Directory サーバーへ接続する際に使用するポー
ト番号。 
• Channel encryption フィールドで SSL を選択した場合、デフォルトのポー
ト番号は 636 です。 
• Channel encryption フィールドで None を選択した場合、デフォルトの
ポート番号は 389 です。 
ディレクトリー・サーバーがこれらの既定のポートのいずれかを使用しない場合は、
別のポート番号を手動で入力します。 

Advanced Options セクション  
Timeout ディレクトリーの検索最大秒数。デフォルトは 60 秒です。 

Active Directory サーバーでタイムアウト値が構成されている場合は、値が小さ
い方が優先されます。 

Maximum number of entries 
returned 

Active Directory サーバーが Domino サーバーの検索に対して返すことができ
るエントリの最大数。ディレクトリー・サーバーに最大設定がある場合は、値が小さ
い方が優先されます。ディレクトリー・サーバーがタイムアウトした場合は、その時点
までに見つかった名前の数が返されます。デフォルトは 100 です。 



 

Dereference alias on search ディレクトリーの検索中にエイリアスの逆参照が行われる範囲を制御するには、次
のいずれかを選択します。 
• Never (実施しない) 
• Only for subordinate entries (下位エントリのみ) 
• Only for search base entries (検索ベースエントリのみ) 
• Always (すべて実施。デフォルト) 
ディレクトリーでエイリアスが使用されていない場合は、Never を選択すると検索
パフォーマンスが向上します。 

Preferred mail format Internet Mail Address を選択 
Enable name mapping 選択しないこと。 
Type of search filter to use Active Directory を選択 

9. Save & Close をクリックします。 

10. Domino 管理サーバーのサーバー・コンソールから次のコマンドを実行して、ディレクトリー・アシスタンス文書のディレクトリ
ー同期構成が正しく設定されていることを確認します。 

show xdir 

下図のように SYNC が表示されていることを確認します。 

 

例: Base DN for search 
ディレクトリー同期に使用されるディレクトリー・アシスタンス文書の Base DN for search フィールドで指定する値は、同
期するユーザーの Active Directory コンテナーの識別名と一致している必要があります。 
 
Active Directory サーバーに接続するには、Apache LDAP ブラウザーや JXplorer などの LDAP ブラウザーを使用しま
す。同期するユーザーを持つコンテナーを検索し、識別名属性(distinguishedName)を調べてください。たとえば、次の図
は、OU=Generated Users,DC=svthcltest,DC=com という識別名を持つ Generated Users と呼ばれる 
Active Directory のコンテナーを示しています。 

 



 

 
ディレクトリー・アシスタンス文書の Base DN for search フィールドにその識別名(DN)を使用します。 

 

2. ディレクトリー同期の構成文書の作成 
ディレクトリー同期が有効になっているディレクトリー・アシスタンス文書を作成したら、Domino ディレクトリーにディレクトリー同
期構成文書を作成します。この文書を使用して、ディレクトリー同期構成オプションを選択し、ディレクトリー同期を有効にしま
す。 
1. Domino ディレクトリーを開きます。 

2. Configuration > Directory > Directory Sync を選択します。 

3. Add Directory Sync をクリックします。 

4. Basic タブ内の以下のフィールドを設定します。 

表 6: Directory Sync Configuration 文書の Basic タブ内のフィールド 
フィールド 解説 

Directory Assistance 
domain 

ディレクトリー同期が有効になっているディレクトリー・アシスタンス文書の LDAP タブの
Domain name フィールドで指定したドメインを選択します (例:Renovations 
AD)。 

注意: ドメインを選択するには、このドメインを指定したディレクトリー同期のディレクト
リー・アシスタンス文書が有効になっている必要があります。 

DirSync status この文書の他の構成オプションを完了したら、Enabled を選択してディレクトリー同期
を有効にします。次のプロンプトが表示されます。 

Begin sync now or run in test mode? (今すぐ同期を開始するか、テスト モー
ドで実行しますか?) 

次のいずれかのオプションを選択します。 

• Synchronize data (データの同期) 
• Run in test mode (log to console, don't update data) (テストモードで
実行(コンソールにログ、データを更新しない)) 

Run in test mode を選択すると、Domino データを変更せずにディレクトリー同
期が実行するアクションをシミュレートできます。ディレクトリー同期構成に必要な調整を
行ってください。実際の同期を有効にする準備ができたら、Synchronize data を
選択します。 

Sync users who are only in 
Active Directory 

• Active Directory のユーザーの情報を同期するには、Yes を選択します。 
• Domino ディレクトリーと Active Directory の両方にいるユーザーと、Active 
Directory にのみいるユーザーについて、情報を同期するには、No を選択します。 

注意: Active Directory レコードを Domino ユーザー文書と同期するには、
Active Directory の mail フィールドが Domino ディレクトリーの Internet 
Address フィールドと一致している必要があります。 

Domino directory file name Domino ディレクトリーのファイル名 (通常は name.nsf)。 



 

Direction 同期の方向。現在、使用できるのは、Active Directory から Domino のみです。 
Rename Domino users 
upon Active Directory 
rename 

• Active Directory でユーザーの共通名が変更されたときに Domino に登録され
ている Domino ユーザーの共通名を変更するには、Yes を選択します。 

詳細については、この後の「Active Directory 上でユーザー名が変更されたときに 
Domino ユーザー名を変更する」を参照してください。 

• No を選択すると、Active Directory でユーザーの共通名が変更されても
Domino で共通名が変更されません。 
注意: Domino で登録していない Active Directory ユーザーの名前が変更された
場合、このオプションに関係なく、Domino ディレクトリーのユーザー文書の名前は自動
的に更新されます。 

Sync frequency DirSync タスクが Active Directory の変更を同期するためにチェックする頻度。デ
フォルトは 1 分に 1 回です。 

表 7: Fields in Synchronization tab of a Directory Sync Configuration document 
フィールド 解説 

Fields to sync to Domino このフィールドを使用して、Domino と同期する Active Directory のユーザーの
フィールドを指定します。既定では、Active Directory のフィールドの標準リストが表
示されます。リストからフィールドを追加、削除できます。あるフィールドに対して Active 
Directory と Domino が異なる名前を使用している場合、Domino フィールド名
は Active Directory フィールド名の後に、括弧付きで表示されます。たとえば、
mail (Email address)です。 

Filter to sync a subset of 
users and groups 

デフォルトでは、Active Directory 内のすべてのユーザーとグループが同期されます。
必要に応じて、標準の LDAP 検索フィルターを使用してサブセットを同期します。たと
えば、フィルター (&(department=hr)st=MN))は、部門(department)が hr
で、且つ、状態(st(atus))が MN であるもののみを同期します。 

Synchronize groups  グループを同期する場合は、同期するグループの種類を選択します。グループを同期
しない場合は、どちらのオプションも選択しないでください。 

• Security groups: Notes アクセス リストで Active Directory セキュリ
ティー・グループを使用できるようにします。 

• Distribution groups: Notes メール・アドレス指定で Active Directory
の配布グループを使用できるようにします。 

 ユーザー情報のみを同期する場合は No を選択します。 

5. Save & Close をクリックします。 

6. DirSync タスクは、構成文書を検出したときに実行を開始します。 

  



 

ディレクトリー同期の状況監視 
ディレクトリー同期を監視するには、次の方法を用います。 

表 8: ディレクトリー同期を監視する方法 
オプション 解説 

サーバー・コンソールと log.nsf の
DirSync 出力を監視する。 

 

Domino ディレクトリーのディレクト
リー同期構成文書の Status タブ
を確認する。 
(Configuration > 
Directory > Directory 
Sync ビューを開きます) 

このタブでは以下の情報を提供します。 
• Sync state (同期の状況): 
0 - Invalid configuration (無効な構成) 
1 – Idle (アイドル) 
3 - Checking for Domino directory changes that are Active 
Directory field violations (Active Directory フィールド違反となっている
Domino ディレクトリーの変更の確認中) 
4 – Syncing (同期中) 
注意: 状態 3 は、Domino ディレクトリー側で変更されたフィールド値が
Active Directory から同期された値と一致しないフィールドをチェックしていま
す。このような変更が見つかると、値は Active Directory 値に戻されます。 

統計値を確認する。 • Last sync time (最終同期時刻) 
• Sync state status: 0 (No errors) (同期状況。Directory Sync
ビューにも表示されます) 
• Sync state warning (同期状況の警告) 
• Incremental "Since" state - Domino Directory since. 
• Incremental "Since" state - LDAP change number. 
• Skipped "Problem" Entries - Duplicate Notes names 
• Skipped "Problem" Entries - Invalid Notes names 
• Skipped "Problem" Entries – Others 

Active Directory上でユーザー名が変更されたときに Domino ユーザー名を変更する 
ディレクトリー同期を使用している環境で、登録された Domino ユーザーの共通名が Active Directory 側で変更された
場合は、次の手順に従って Domino ディレクトリーのユーザー文書の名前も変更します。作業には Notes 認証者のパスワ
ードが必要です。 

Active Directory の構成文書内の Rename Domino users upon Active Directory rename オプションは
有効にする必要があります。Active Directory 上で Domino ユーザーの共通名が変更されると、Rename Common 
Name 管理プロセス要求が作成されます。Domino で行われる名前変更要求を承認する必要があります。 

注意: この手順は、Domino に登録されていない Active Directory ユーザーの名前が変更された場合には必要ありませ
ん。この場合、同期することで Domino ディレクトリーのユーザー文書で名前が直ちに更新されます。 

1. システム管理要求 (Administration Requests) データベース (admin4.nsf) を開きます。 

2. ビューの Requests > Rename Common Name Requests を開きます。このビューには、Active 
Directory で共通名が変更された Domino ユーザーの名前だけが表示されます。 

3. 処理する名前を選択し、Complete rename for selected entries をクリックします。 



 

4. プロンプトが表示された場合は、Notes 認証パスワードを入力します。 

処理される名前ごとに、標準の管理プロセスの Rename Person が開始されます。 

Domino上での Active Directory ユーザーの登録  

ディレクトリー同期を使用すると、Domino 側で Active Directory ユーザーを登録して、メール・ファイルと Notes ID を作
成できます。 

1. Domino Administrator で People & Groups タブをクリックします。 

2. 追加したい Active Directory のユーザーを選択します。 

3. 右クリックで Register Selected Person を選択します。 

4. Use the current Active Directory contract record <ユーザー名>? の プロンプトが表示されたら Yes を選
択します。 

ユーザーとグループの削除 
ユーザーまたはグループが Active Directory で削除されると、Domino ディレクトリーにも削除されますが、1 つの例外があ
ります。Domino ユーザー(メール ファイルなどを持つ)として登録された Active Directory ユーザーは Domino からは削
除されません。 

ディレクトリー同期の構成の変更 
ディレクトリー同期の構成を変更するには、ディレクトリー同期を無効にし、ディレクトリー同期構成文書を編集してから、ディレ
クトリー同期を再度有効にします。 

1. Domino ディレクトリーを開きます。 

2. Configuration > Directory > Directory Sync を選択します。 

3. 変更するディレクトリー同期構成文書を選択します。 

4. Disable をクリックします。 

5. ビューが無効になっていることが表示されるまで待ちます。 

6. ディレクトリー・アシスタンス構成文書に変更を加えます。 

7. 文書の先頭で Enable をクリックします。次のプロンプトが表示されます。 

Begin sync now or run in test mode? (今すぐ同期を開始するか、テスト モードで実行しますか?) 
Choose one of the following options: (次のいずれかのオプションを選択します。) 
• Synchronize data (データの同期) 

• Run in test mode (log to console, don't update data) (テスト モードで実行する (コンソールにログを
記録し、データを更新しない)) 

Run in test mode を選択すると、Domino データを変更せずに、ディレクトリー同期が実行するアクションをシミュレ
ートできます。ディレクトリー同期構成に必要な調整を行います。実際の同期を有効にする準備ができたら、
Synchronize data を選択します。 

  



 

すべてのデータの再同期 
すべての Active Directory データを再同期できます。同期するデータに影響するディレクトリー同期構成文書に変更を加
えた場合は、再同期します。再同期は、通常の増分同期と並行してバックグラウンドで実行される DirSync スレッドを介して
行われます。 
1. Domino ディレクトリーを開きます。 

2. Configuration > Directory > Directory Sync を選択します。 

3. 再同期するドメインのディレクトリー同期構成文書を選択します。 

4. Resync ボタンをクリックします。 

 
 
 

  



 

開発者向けの新機能 
 

Domino Query Language の拡張機能 
Domino Query Language (DQL) は、Domino 11 で以下の機能を強化します。 
 
• 設計カタログは、クエリーが処理される個々のデータベースの非表示ビュー内で保持されるようになりました。以前は、別の

データベースである GQFdsgn.cat が複数のデータベースの設計要素を格納していました。新しい updall コマンド・オプ
ションである -e と -d が追加され、設計カタログの追加と更新に使用されます。 

• 注意: Domino 11 ベータ版では、Domino 11 で非推奨となる GQFdsgn.cat の作成を防ぐために、サーバーの 
notes.ini に INBOARD_DESIGN_CATALOG=1 を追加する必要があります。 

• 全文索引に対して DQL 処理を実行できる機能が追加されました。これは通常、最速の DQL 処理方法となります。新
しい contain 演算子は全文索引のクエリーで使用されます。 

• ビューの DQL 処理が強化されました。ベータ版では、この機能を使うには、サーバーの notes.ini に
QUERY_VIEW_SEARCH_OPTIMIZE=1 を設定します。この設定は、製品版ではデフォルトで設定される予定で
す。 

Domino Query Language のドキュメント 
Domino クエリー言語 (DQL) に関するドキュメントは現在、Domino AppDev Pack のドキュメントで提供されています
が、Domino 11 では Domino Designer のドキュメントに移動されます。DQL の完全な文書については、そちらを参照し
てください。 

Domino Query Language の概要 
Domino クエリー言語(DQL) は、簡潔な構文で文書を検索するための、Domino サーバー上で実行される機能で、複雑
な検索条件を指定できます。詳細なコードを記述することもなく、既存の設計要素を活用して文書にアクセスできます。DQL 
は、Domino における文書検索のすべてのメソッドを統合するものです。 

はじめに(Getting started) 
Domino クエリー言語 (DQL) を使用する前に、クエリー要求が処理に利用する内部設計カタログを各データベースに作成
します。設計カタログは、データベース内の隠し文書として保持され、DQL の実行時に重要な設計データを検索するための高
速なしくみとなります。 
 
注意: ベータ版の場合は、サーバーの notes.ini に INBOARD_DESIGN_CATALOG=1 を追加する必要があります。こ
の設定により、V10 で使用されていた GQFdsgn.cat が作成できなくなります。 GQFdsgn.cat は V11 では非推奨となり
ました。 

DQL 処理では、設計カタログ内の抽出された最適化された設計データを使用して、クエリー・プランに関するインテリジェントな
選択を行い、ビュー名などの構文要素の一部を使用します。 

設計カタログをデータベースに追加するには、次の updall コマンドを使用します。  

load updall <mydb.nsf> -e 

デザイン カタログを最新の状態に保つために updall の使用が必要ですが、設計カタログの詳細については、この後の「設計



 

カタログ」を参照してください 

DQL syntax 
DQL は、Notes データベース・オブジェクトまたは domino-db node.js API 上で、LotusScript または Java Query メ
ソッドで実行できます。[and] を使用してオプション トークンを示すと、DQL の構文は次のようになります。 

Term Boolean Term [ Boolean Term ...] 

ここで示される Team と Boolean Term の構文は以下の通りです。 
 
表 9: DQL Term and Boolean syntax DQL 条件とブール構文 

要素 要素 要素 値 
Term    
 [Identifier]   
  SummaryField | ‘View or 

folder 
name’.Columnname | 
@function 

 

   SummaryField とは、Domino データベース内の文書のサマリー
部分に格納されているフィールドの名前です。 
View or folder name とは、Domino データベースで作成された
ビューまたはフォルダーの名前、あるいはその別名です。 
Columnname は、ビューまたはフォルダーで、プライマリ・ソートされ
た列のプログラム名です。 
@function is @all | @ModifiedInThisFile | 
@DocumentUniqueID | @Created 

Operator    
[Value]  Quoted string value ’ | 

@dt(‘ datetime value 
’) | number | ( in value 
list ) 

 

   Quoted string value とは、datetime のフィールドまたはビュー
列で見つかったテキスト値です。 

datetime は GMT または Zulu 時間番号で指定された
ISO8601 準拠の値です。 

number は科学的表記を含む小数点の有無にかかわらず、浮動
小数点数です。 

値リストは以下の形式をとります。 

' 値 1' [ ,'値 2' ... 
Boolean   and | or | and not | or not 

  



 

単純なクエリーの例 
単純なクエリーの例を次に示します。 

番号 146751 以降、150111 まで(150111 を含む)の注文番号を持つすべての伝票を検索する場合。 

order_no > 146751 and order_no <= 150111 

営業担当者フィールドで指定された 4 つの値のいずれかを持つすべての文書を検索します。 

sales_person in (‘Chad Keighley’, ‘Jeff Chantel’, ‘Louis Cawlfield’, ‘Mariel 
Nathanson’) 

Domino 11の新機能: sales_person フィールドに Chad という単語、Chant で始まる単語、C で始まり任意の 2 文
字が続き field で終わる、いずれかの条件に合致するすべての文書を検索します。 

sales_person contains (‘Chad’, ‘Chant*’, ‘C??lfield’) 

2018 年 10 月 10 日 10:00.00 EST より後に送信されたすべての文書を検索します。 

date_origin > @dt(‘2018-10-10T10:00:00+0500’) 

Orders ビューを使用して、order_type 列で Phone の値を持つ文書を検索します。 

‘Orders’.order_type = ‘Phone’ 

任意の名前付きビューとフォルダー内の文書を検索します。 

in (‘Orders’, ’Special orders folder 1’, ‘Old_orders 2’) 

値のデータ形式 
Domino はタイプレス・データ・モデルを備えており、任意のタイプのデータを任意のフィールドに格納できます。DQL クエリーで
は、検索されるデータのタイプは、クエリー条件で指定されたデータのタイプによって決まります。 
• 文字列の検索では、テキスト形式の値のみを検索。 

• 日付/時刻検索(@dt(‘2018-08-01T11:18:00.00+0500’)など)では、日付/時刻形式の値のみを検索。 

• Numeric searches such 128992E-2 or 1289 only match numerals. 数値検索(128992E-2 や 1289
など)では、数値形式の値のみを検索。 

Booleans 
単純なクエリーと Boolean 処理を組み合わせた例を次に示します。 

order_origin フィールド値が ‘London’、‘LA’、‘Tokyo’、かつ(AND)、販売日が 2016/05/12 以降(英語表記では
greater than 2016/05/11)、または(OR)パーツ番号 388388 を含む文書を探す場合。 

Order_origin in (‘London’, ‘LA’, ‘Tokyo’) AND date_origin > @dt(‘20160511’) 
or partno = 388388 

Soon to be special ビューの Status 列を使用して、Shipping の値を持つ文書を検索し、且つ (AND)、
order_origin が ‘LA’、あるいは (OR) Chad Keighley, Jeff Chantel, Louis Cawlfield、Mariel Nathanson の
いずれかによりが販売された文書を検索します。 

'Soon to be special’.Status = ‘Shipping’ and ( order_origin = ‘LA’ or 
sales_person in (‘Chad Keighley’, ‘Jeff Chantel’, ‘Louis Cawlfield’, ‘Mariel 
Nathanson’))** 

  



 

‘Soon to be special’ ビューの Status 列を使用して ‘Inventory’ の値を持つ文書を検索し、且つ (AND)、
order_origin が ‘Detroit’ あるいは (OR) Harold Cunningham, Julie Leach, Gordon Smith of Terence 
Henry のいずれによっても販売されていない文書を検索します。 

‘Soon to be special’.Status = ‘Inventory’ and ( order_origin = ‘Detroit’ or 
NOT sales_person in (‘Harold Cunningham’, ‘Julie Leach’, ‘Gordon Smith’, 
‘Terence Henry’)) 

Precedence 
DQL には、AND 条件がつけられた部分が OR 条件がつけられた部分よりも前に処理されるという、既定の (natural) 優
先順位 (処理順序) があります。 

以下の例では、order_origin と date_origin の結果が AND で条件付けされていて、さらにその結果が OR を使って
partno の結果との間で条件付けされています。 

partno = 388388 or order_origin in (‘London’, ‘LA’, ‘Tokyo’) AND date_origin 
> @dt(‘20160511’) 

既定の優先順位をオーバーライドするには括弧を使用します。次の例では、date_origin と partno を囲む括弧は、それら
が order_origin との間で、OR で条件付けされていることを意味します。 

order_origin in (‘London’, ‘LA’, ‘Tokyo’) AND (date_origin > dt(‘20160511’) 
or partno = 388388)in all 

all キーワードは、in 演算子で含まれる内容から、指定された値のリストを除き、除外するよう動作します (分かりにくい可能
性があるため原文を併記します。The all keyword modifies the inclusive in operator to exclude all but a 
specified list of values.)。 

次の例では、part_no の値として 389、27883、388388、587992 をすべて含む文書のみが検索されます。 

part_no in all ( 389, 27883, 388388, 587992 ) 

次の例では、すべてのフォルダーとビューに含まれる文書のみを検索します 

‘Orders’, ’Special orders folder 1’ and ‘Old_orders 2’: in all (‘Orders’, 
’Special orders folder 1’, ‘Old_orders 2’) 

contains 
V11の新機能: NSF スキャンやビュー・インデックスの使用に加えて、DQL は、全文索引に対するクエリーを処理する 
contains 演算子を提供します。この方法で処理するには、データベースに全文索引が必要です。 
 
contains を使って、特定のフィールド、あるいは文書内のすべてのフィールドでテキスト文字列を検索します。次の 2 つの例
は、特定のフィールドについて特定のテキスト文字列を検索します。 

Sales_person contains (‘Trudi’, ‘Jack*’) Order_description contains all 
(‘diagonal’, ‘brushed nickel’, ‘cap*’) 

次の 2 つの例では、フィールド名を省略し、文書内のすべてのテキスト・フィールドで特定のテキスト文字列を検索します。 

contains (‘Mercury’, ‘spinning wildly’, ‘orbit*’) 

contains all (‘Tiger Lily’, ‘Pete*’, ‘Lost boy?’) 

all を使用すると、指定したすべての文字列を含む文書のみを検索します。指定した文字列のいずれかを含む文書を検索す
るには all を省略します。 

  



 

* のワイルドカードを使用して、複数の文字を一致させられます。? のワイルドカードを使用すると 1 文字分のワイルドカードに
なります。contains に関する追加情報は以下の通りです。 

• テキスト値のみが検索されます。数値と日付は検索できません。 

• 多くの場合で、文書の内容を検索する最も高速な方法です。 

• 全文索引が必要です。データベースに全文索引がない場合、クエリーはコンパイルに失敗します。 

• ベータ版のみ: 全文索引は、Domino V10 自動更新ルールに従って更新されます。V11 GA では、全文索引の更
新オプションが計画されています。 

注意: contains と = は等価ではありません。contains はテキストを部分一致で検索します。= はフィールドの値との完
全一致で検索します。たとえば、文書の sales_person フィールドに Trudi Ayton が含まれている場合、次の 2 つのクエリ
ーのうち最初のクエリーでのみヒットします。 

sales_person contains (‘Trudi’) 

sales_person = ‘Trudi’ 

テキスト文字列値 
テキスト文字列の評価では大文字と小文字を区別されませんし、アクセント記号も区別されません。単一引用符 (') を使
用すると、DQL 処理に対して強制的に引数を日付/時刻や数字ではなくテキストとして解釈させられます。 

テキスト文字列に引用符が含まれている場合は、隣接する単一引用符を使用して、テキスト文字列であることを示します。
たとえば、O'Malley's dog's collar を検索するには、O''Malley''s dog''s collar を指定します。 

日付と時刻の値 
DQL は、日付時文字列の RFC3339 標準フォーマットをサポートします。以下の各値は許容される値です。 

@dt('2019-08-06T02:09:52Z') 

@dt('2019-08-06T02:09:52.6800+04:00') 

@dt('2019-08-06') 

@dt('02:09:52') 

@dt('02:09:52.6800') 

@dt('02:09:52.6800+05:00') 

すべての演算子はすべての日時の値に対して機能します。さらに、@created 関数識別子と@modifiedinthisfile 関数
識別子は@dt('')値を使用します。したがって、部分的な日付は、指定された部分、つまり特定の日、その日、および任意の
日内の秒(またはサブ秒)の場合、その秒の値により一致します。タイムゾーン修飾子(+ または – hh:mm サフィックス)がな
い場合は、すべての時間が UTC 値(GMT)となれます。ローカル時間を指定するにはタイムゾーン・サフィックス修飾子を使用
します。 

注意: ビュー検索では、部分的な日付値はヒットしません。たとえば、次のクエリーは評価エラーを返します。 

'myview'.datefield < @dt('2018-09-01') 

'myview'.datefield = @dt('02:09:52') 

部分的な日付値を使用してビュー検索を行う場合で、日付の検索が必要だが時刻が重要でない場合には、値全体を指定
します。以下に例を示します。 

'myview'datefield < @dt('2018-09-01T00:00:00.000Z') 



 

置換変数 
ある条件式のもとで、条件の値が変化する DQL クエリーの実行は便利であるため、文字列構造(string construction)を
使用してクエリーを構築したくなります。しかし、文字列構造を使用して DQL クエリーを構築すると、セキュリティー上の弱点に
なる可能性があります。DQL は置換変数を構文でサポートしているので、クエリーを変更せずに異なる値を指定できます。 

文字列構築を使用して構築されたクエリーの Java 例は次のとおりです。order_num and と order_origination は、コ
ード自体の外部から指定された値を持つフィールドです。 

String query = "order_no = " + order_num + " and order_origin = '" + 
order_origination + "'"; 

この手法を使用してクエリーを構築すると、セキュリティー上の問題が発生します。ユーザーや外部マルウェアは、クエリーの結果
を変更して、データベース内のすべての文書など、より多くの文書を検索する正当な DQL を入力することで、クエリー構文を
変更できます。たとえば、order_num に次の値が含まれている場合、クエリーのその部分はデータベース内のすべての文書
を検索します。これは悪名高い SQL インジェクションの露出です。 

"32890 or order_origin <= ''" 

この弱点をなくすために、DQL は構文の置換変数をサポートします。置換変数を使用すると、クエリーを変更せずに、必要な
さまざまな結果を生成する異なる値を指定できます。置換変数には、位置変数(positional)と名前付き変数(named)の
2 種類があります。 

位置置換変数はクエリーに疑問符を指定します。次の例では、値は 1 ベースの代入によって提供され (supplied via 1-
based assignment)、order_no 値は変数 1 で、order_origin は変数 2 です。 

String query = "order_no = ? and order_origin = ?"; 

名前付き置換変数は、疑問符の後に、名前を構成する 1~15 バイトの英数字と特殊文字のテキスト名が続きます。値は
疑問符の後のテキストのみを使用して指定されます。同じクエリーを名前付き置換変数で表現すると以下の通りになります。 

String query = "order_no = ?order_num and order_origin = ?order_origin"; 

Domino Java および LotusScript クラスは、名前付き置換変数のみをサポートします。 

各言語での、これらの変数値を設定する方法の詳細については、Domino Designer のドキュメントを参照してください。 

列の要件の表示 
DQL 処理ではビュー・アクセスのプライマリー照合列が必要で、特定の要件を満たす必要があります。ビュー列は、次のいずれ
かの照合順序規則(collation rules)に準拠している必要があります。 

• ビューで [昇順の並べ替え] に設定された左端の列を持つ照合列であること。 
または 
• Designer のビュー列照合タブで Click on column to sort Ascending にチェックが入った列であること。 

Notes クライアントでは、これらの要件のいずれかを満たす場合、列名の上にマウスオーバーすると、カレットが表示されます。 

さらに、DQL 処理に<SummaryField><Operator><Value>構文を使用するには、ビュー列に次の 3 つの属性も必
要です。 

• ビューの選択基準として Select @All を使用する必要があります。 
• ビューは、計算式としてフィールド名のみを含む照合列である必要があります。 
• ビュー列はカテゴリー化されておらず、Show multiple values as separate entries にチェックが入っている必

要があります。 



 

<SummaryField><Operator><Value>条件のビュー・インデックスが見つからない場合は、NSF スキャンが使用され
ます。 

<'ビューまたはフォルダー名'>.<列名>構文を使用するには、ビューが選択基準として Select @All を使用する必要があり
ます。<'View またはフォルダー名'>.<Columnname>が使用され、照合順序の要件とこの要件が満たされない場合、ク
エリーは戻りコードを伴ってエラーが返ります。 

注意: <''ビューまたはフォルダー名'>.<Columnname>条件は、文書の結果セット、ビュー選択基準、およびクエリー条
件自体に対して 2 つのレベルのフィルター処理を適用します。 

スキャン制限 
DQL 処理エンジンでは、システム リソースの過度な消費を回避するための手段が講じられていますが、ランナウェイ・クエリーを
記述して実行することは可能です。それを防ぐために、3 つの制限設定が用意されています。 

• MaxDocsScanned –最大スキャン NSF 文書数 (デフォルト 200000)  
• MaxEntriesScanned – スキャン済みの最大インデックス・エントリー数 (デフォルト 200000) 
• MaxMsecs – ミリ秒単位の最大消費時間 (デフォルト 120000) (2 分)  

サーバーの notes.ini 設定を使用して、DQL 処理の以下の既定値を変更できます。 

• QUERY_MAX_DOCS_SCANNED = <スキャンされたシステム全体の最大 NSF 文書数 
• QUERY_MAX_VIEW_ENTRIES_SCANNED = <スキャンされたシステム全体の最大ビュー・エントリー数> 
• QUERY_MAX_MSECS_TOTAL = <システム全体の最大クエリー消費時間 (ミリ秒単位) 

DQL エンジンの API インターフェイスを使用してこれらの設定を変更可能です。 

パフォーマンスとリソース消費 
DQL 処理は、メモリ、ディスク、および CPU リソースを消費します。リソース消費を抑え、クエリー処理を高速化するには、クエ
リーを可能な限り最適化してください。DQL でクエリー条件を実行するには、次の 3 つの方法があります。 

• NSF data scans NSF データ スキャン 
• View entry scans エントリ スキャンの表示 
• V11の新機能: 全文索引へのアクセス 

一般的に、全文索引を使用するのが最も効率的な使用方法であり、その次にビュー・エントリーと NSF サマリー・スキャンが
続きますが、データのカーディナリティー、ビューの構造、結果のサイズによって異なる場合があります。少数または中程度の量
の文書を検索する等価検索(equality searches)では、ビューを使用すると特に高速です。そのため、DQL エンジンが、全
文索引とビューを使用して、どのようにアクセスを最適化しているかの方法を知ることはとても重要になります。次の表は、DQL 
の実行を多面的に示したものです。 

表 10: DQL の実行の比較 
検索方法 Full text search View scan NSF scan 
相対的な処理速度 最速 より速い 速い 
実行順序 1 2 3 
サポートされる 
演算子 

contains, wildcard =, >, >=, <, <=, IN, 
‘viewname’.column 

=, >, >=, <, <=, IN 

統合
(Consolidation) 

AND でくくられた条件の組
み合わせ (ANDed terms 
coupled) 

AND でくくられた範囲の条
件の組み合わせ (ANDed 
range terms coupled) 

すべての兄弟要素を同時に実行
(All siblings executed 
together) 



 

 
統合に関して、DQL は複数の条件を組み合わせて、最適だと判断された場合に、単一のスキャンまたは索引検索操作を実
行します。DQL はまた、以前のものの結果と後続の条件を読み込み、全体的なコストを大幅に制限します。たとえば、
term1 によって削除された文書は、term2 で ANDed された条件では検索されません。 

DQL 処理は、Domino サーバーの通常の動作と組み合わせて非常によく機能しますが、決してコストがゼロではありません。
読み取り専用ビューのアクセスは、NSF サマリー データ アクセスと同様に増加します。この処理は Domino サーバーにとって
新しいものではありませんが、関連する処理への悪影響を避けるために、その影響を調査する必要があります。 

ビューまたはフォルダーのインデックスを使用するには、そのインデックスに特別なプロパティが必要です。 

ベータ版では、次のサーバーの notes.ini 設定を使用して、ビュー処理を最適化します。 

QUERY_VIEW_SEARCH_OPTIMIZE=1 

V11 の製品版では、この設定はデフォルトでオンになります。 

設計カタログ (Design catalog) 
ビューとビュー列の内部情報に高速でアクセスするために、DQL 処理では設計カタログにアクセスします。設計カタログにはビュ
ー・ノートから抽出された設計データが格納されています。updall コマンドを使用すると、個々のデータベースに設計カタログが
追加され、設計カタログが最新の状態に保たれます。 

データベースがカタログ処理されると、DQL クエリーは設計カタログなしで動作します。ただし、<'View or folder 
name'>.<Columnname>構文のみは失敗します。他のすべての構文は機能しますが、ビュー・アクセスはなく、すべての
条件は、NSF をスキャンすることで満たされます。 

DQL 処理は、個々のデータベースに設計カタログを追加することで大幅に強化されます。データベース内に設計カタログを作
成するには、次のコマンドを使用します。 

load updall <database path> -e 

<database path>を省略すると、データ・ディレクトリー配下のすべてのデータベースに設計カタログが追加されますが、これ
はお勧めできません。アプリケーションが DQL を実行するために必要なものではあるものの、カタログが巨大な状態になるため
です。 

ビューのデザインを変更したりビューを追加した場合は、次のコマンドを実行して設計カタログを更新し、変更が DQL から認識
できるようにします。 

load updall <database path> -d 

注意: これら 2 つの updall コマンドは必ず手動で実行する必要があります。 

DomQuery ユーティリティー 
DomQuery コマンドライン・ユーティリティーは Domino サーバーに同梱されており、クエリーの作成と調整に使用します。
explain(-e)フラグと共に実行すると、DQL 構文の理解と最適化、そしてクエリーがどのように処理されているかを理解するの
に役立ちます。DomQuery は、NSF ファイル内のデータをフェッチしたり、更新したりしませんが、クエリーの作成と最適に役
立ちます。 

DomQuery を使用するには、以下のフラグと共にサーバー・コンソールで tell domquery コマンドを使用します (Linux と
AIX では、domquery を小文字にする必要があります)。 

• -f [DBName] データ・ディレクトリーの相対パス (必須) 
• -q [double quoted string query] クエリー文字列。-q あるいは -z ファイルが必須 



 

• -z [QueryFile path] 開始行の直前で #* で区切られた、クエリー構文クエリーを含むファイルへのフル・パス 
• -e ノードの説明 
• -p パースのみ (テスト目的) 
• -v [MaxEntries] スキャンされる最大ビュー・エントリー数 
• -c [MaxDocsScanned] スキャンされる最大文書数 
• -m [Msecs] 最大実行時間(ミリ秒) 
• -x エラー時に Exit する (-z file case) 
• -j ビュー処理を実行しない(NSF 文書のみをスキャンと FT) 
• -o [Output Report File path] 出力が書き込まれるファイルへのフル・パス 

explain 
DQL 構文の処理方法を理解する最良の方法は、explain(-e) フラグを持つ DomQuery ユーティリティーを使用すること
です。以下のクエリーを考えてみます。 

ord_status contains ('shipping') and sales_person = 'Trudi AYton' and 
order_origin = 'Detroit' 

以下の図は explain の出力です。 

 

この例では、DQL 処理は、すべての "兄弟" 演算子と (AND) ブール演算子を単一の親ノードとして扱い、個々の条件を
子として扱っています。各条件は、ビュー処理または NSF スキャン操作によって、ひとつの全文検索としてサービスされます。エ
ントリ (ビュー) または ScannedDocs (NSF スキャン) の数は、この条件を満たすために行われた相対的な作業を示してい
ます。Prep と Exec という 2 つのミリ秒のタイミングがあり、Prep は条件のコンパイル、検証、および準備に要した時間で、
Exec はそれを実行する時間です。FoundDocs 値は、条件を通過したドキュメントの合計を示します。 

すべてのカウントとタイミングは、クエリーの合計コストが表示される親ノードにロールアップされます。 

クエリーがより複雑になると、explain の出力がより複雑になります。しかし、これらの同じチューニング方法は、パフォーマンスを
最適化する上で効果的です。 

• タイミングとカウントの両方を使用して、最もコストのかかる条件を検索します。 

• 可能であれば、contains 演算子の使用を検討してください。 

• フィールド条件については、使用するフィールドの全体的な使用状況を考慮します。クエリーで一般的に使用される 
PLUS は非常にコスト高です。上記で示した属性を持つビュー列を作成して、条件の最適化を検討してください。 

• ビュー列の条件の場合は、幅 (列の数) とビューのサイズを考慮します。列数の少ないビューや、より制限の厳しい選択
基準を持つビューを使用できる場合は、その実施を検討してください。 

一般的に、中間の結果をできるだけ小さくしておくことが重要です。この点に関して、AND 条件は結果を縮小し、OR 条件は
大きくします。もちろん、アプリケーション・ロジックには要件がありますが、結果のサイズも考慮する必要があります。 



 

Traveler の新機能 
 
HCL Traveler 11 の新機能は以下の通りです。 

カレンダー・イベントでの添付ファイルの閲覧 
イベントの説明に添付ファイルを含む Notes または Verse Web ユーザーから招待状を受け取った場合、デバイスが機能を
サポートしている場合は、モバイル・デバイスから添付ファイルを開いたりダウンロードしたりできます。インラインの添付ファイルを
開いたりダウンロードしたり、添付ファイルを作成または編集したりすることはサポートされていません。 

ActiveSync 16.xのサポート 
Traveler は Microsoft Exchange ActiveSync 16.0 と 16.1 を iOS でサポートします。これにより、カレンダーの添付
ファイルを同期する機能など、このバージョンを必要とする将来の機能を開発できるようになりました。Traveler は
ActiveSync 16.x が利用可能なデバイスの場合には、16.x 対応の動作に切り替わります。ユーザーの操作は必要ありま
せん。 

APNS HTTP/2のサポート 
Traveler は、アップルのアップルプッシュ通知サービス(APNS)サーバーとの通信のための HTTP/2 をサポートしています。構
成は不要で、動作に変更はありません。 
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